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10-1 Descriptions of Digital Keypad

KPC-CCO01

s £ aerra
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Communication Interface
RJ45 (socket), RS-485 interface

Communication protocol:
RTU19200, 8, N, 2

Installation Method

1. The embedded type can be installed flat on the surface of the control box. The

front cover is waterproof.

Buy a MKC-KPPK model for wall mounting or embedded mounting. Its

protection level is IP66.

The maximum RJ45 extension lead is 5 m (16ft).

4. This keypad can only be used on Delta’s motor drive C2000 series, CH2000
and CP2000 series.

e
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STOP
RESET

Keypad Function Description

Key

Descriptions

Start Operation Key

1. Only valid when the source of operation command is the keypad.

2. Operates the AC motor drive by the function setting. The RUN LED will be ON.
3. Can be pressed repeatedly at the stop process.

STOP
RESET

Stop Command Key.
1. This key has the highest priority when the command is from the keypad.
2. When it receives the STOP command, regarless of whether the AC motor drive is in
operation or stop status, the AC motor drive executes the “STOP” command.
3. Use the RESET key to reset the drive after a fault occurs.
4. If you cannot reset after the error:
a. The condition which triggers the fault is not cleared. After you clear the condition, you can
then reset the fault.
b. The drive is in fault status when powered on. After you clear the condition, restart and
then you can reset the fault.

Operation Direction Key
1. Only controls the operation direction, NOT the drive activation. FWD: forward, REV: reverse.
2. Refer to the LED descriptions for more details.

ENTER Key
Goes to the next menu level. If at the last level, press ENTER to execute the command.
ESC Key
ESC Leaves the current menu and returns to the previous menu; also functions as a return key or|
cancel key in a sub-menu.
Returns to the main menu.
Menu commands:
1. Parameter Setup 7. Language Setup 13. Start-up Menu
2. Quick Start 8. Time Setup 14. Main Page
3. Application Selection List 9. Keypad Locked 15. PC Link
4. Changed List 10. PLC Function 16. Start Wizard
5. Copy Parameter 11. Copy PLC
6. Fault Record 12. Display Setup
A v Direction: Left/ Right/ Up / Down
1. In the numeric value setting mode, moves the cursor and changes the numeric value.
< > 2. In the menu / text selection mode, selects an item.
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Key Descriptions
Function Key
1. The functions keys have defaults and can also be use-defined. The defaults for F1 and F4
F1 F2 work with the function list below. For example, F1 is the JOG function, and F4 is a speed
setting key for adding / deleting user-defined parameters.
F3 F4 2. Other functions must be defined using TPEditor.

Download TPEditor software at Delta website. Select TPEditor version 1.60 or above.
Refer to the installation instruction for TPEditor in Section 10-3.

HAND Key

1. Use this key to select HAND mode. In this mode, the drive’s parameter settings for frequency
command source is Pr.00-30, and that for operation command source is Pr.00-31.

2. Press the HAND key at STOP, then the setting switches to the HAND frequency source and
HAND operation source.

3. Press HAND key at RUN, and it stops the AC motor drive first (displays AHSP warning), and
switches to HAND frequency source and HAND operation source.

4. Successful mode switching for the KPC-CCO01 displays HAND mode on the screen.

AUTO Key

1. The default of the drive is AUTO mode.

2. Use this key to select AUTO mode. In this mode, the drive’s parameter settings for frequency
command source is Pr.00-20, and that for operation command is Pr.00-21.

AUTO 3. Press the AUTO key at STOP, then the setting switches to the AUTO frequency source and

AUTO operation source.

4. Press AUTO key at RUN, and it stops the AC motor drive first (displays AHSP warning), and
switches to AUTO frequency source and AUTO operation source.

5. Successful mode switching for the KPC-CCO01 displays AUTO mode on the screen

[@- The defaults for the frequency command and operation command source of HAND / AUTO mode are
NOTE
both from the keypad.

LED Functions Descriptions

LED

Descriptions

STOP
RESET

Steady ON: STOP indicator for the AC motor drive.
Blinking: the drive is in standby.
Steady OFF: the drive does not execute the “STOP” command.

FWD
REV

Operation Direction LED

1. Green light: the drive is running forward.

2. Red light: the drive is running backward.

3. Flashing light: the drive is changing direction.

Operation Direction LED under Torque Mode

1. Green light: when the torque command = 0, and the motor is running forward.
2. Red light: when the torque command < 0, and the motor is running backward.
3. Flashing light: when the torque command < 0, and the motor is running forward.
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LED Descriptions
RUN LED:
HED Condition / State
status
CANopen at initial state
OFF No LED
CANopen at pre-operation state
ON-
Flashing 200 | 200
“ms | ms
CANopen—RUN OFF
CANopen at stopped state
Single | ON 200 [ 200 ) 1000 R
as “ms | ms | ms "
OFF
CANopen at operational state
ON
ERR amm—CAN  quy RUN
ERR LED:
HED Condition / State
status
OFF No failure
At least one packet of CANopen is in failure
Single ON
flash :200 < 1000 >
ms ms
OFF
Node guarding failure or heartbeat message failure
CANopen—-ERR _
Double ON"200] 200 [200 | 1000 R
as “ms' | ms | ms | ms "
OFF
Synchronization failure
Tripl
fmer | ONT 200 200 [200 ] 200 [200 ], 1000 .
"ms | ms | ms | ms | ms | ms "
OFF
Bus off
ON ERR amm—CAN oue RUN
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10-2 Function of Digital Keypad KPC-CCO01

POWER ON

1) The default Start-up page is Delta Logo. (Default 1 and 2)

2) User can customize their start-up page through the edited function.
(Need to purchase the optional accessories.)

—>» The top line of LCD displays the status of drive.

After you select the main menu, the start-up screen displays in the
user-defined format. The page on the left shows the Delta default setting.

— The bottom line of LCD displays time and JOG.

Press[ vj once Press(v | again Pressfv | again

—>

Press
MENU
1: Parameter Setup 6: Fault Record 11: Copy PLC
2: Quick Start 7: Language Setup 12: Display Setup
3: Application Selection List 8: Time Setup 13: Start-up Menu
4: Changed List 9: Keypad Locked 14: Main Page
5: Copy Parameter 10: PLC Function 15: PC Link

16: Start Wizard

(I=RINOTE|
1.

Start-up screen can only display pictures, not animation.

2. When powered ON, it displays the start-up screen then the main screen. The main screen displays Delta’s default
setting F/H/A/U. You can set the display order with Pr.00-03 (Start-up display). When you select the U screen, use the
left / right keys to switch between the items, and set the display order for the U screen with Pr.00-04 (User display).

Display Icon
® : present setting
V¥ . Scroll down the page for more options
™~
Press % for more options

=

> : show cgmglete sentence
Press(< |3 for complete information

Display item

MENU

1: Parameter Setup 6: Fault Record 11: Copy PLC

2: Quick Start 7:Language Setup 12: Display Setup
3: Application Selection List 8: Time Setup 13: Start-up Menu
4: Changed List 9: Keypad Locked 14: Main Page

5: Copy Parameter 10: PLC Function 15: PC Link

16: Start Wizard
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1. Parameter Setup

Press@to select.

Press & ¥ to selectthe
parameter group.

Once you select a parameter

group, press@to go into

For example: Setup source for the master frequency command.

- In the Group 00 Motor Drive Parameter,
use Up/Down keys to select parameter 20: Auto
Frequency Command.

Press ENTER to go to this parameter’s setting menu.

' Use the Up/Down keys to choose a setting.
For example: choose 2 Analogue Input, and then press
ENTER key.

After you press ENTER, END is displayed which
means that the parameter setting is done.

that group. NOTE: When parameter lock / password protection
function is enabled, it displays “Pr. lock” on the upper
right corner of the keypad. The parameter cannot be
written or is protected by the password under this
circumstances.
2. Quick Start
| Description:
‘ 1. VF Mode
: 5 . ltems
‘ __ 1. Parameter protection password input
il (Pr.00-07)
: 2. Parameter protection password setting
(Pr.00-08)
Press@to select. —

Quick Start:

V/F Mode
VFPG Mode
SVC Mode
FOCPG Mode
TQCPG Mode
My Mode

oL

Control mode (Pr.00-10)

Speed control mode (Pr.00-11)

Load selection (Pr.00-16)

Carrier frequency (Pr.00-17)

Master frequency command source / Source
selection of the PID target (AUTO)(Pr.00-20)
Operation command source (AUTO)
(Pr.00-21)

9. Stop method (Pr.00-22)

10. Digital keypad STOP function (Pr.00-32)

11. Max. operation frequency (Pr.01-00)

12. Output frequency of motor 1 (Pr.01-01)

13. Output voltage of motor 1 (Pr.01-02)

14. Mid-point frequency 1 of motor 1

(Pr.01-03)

Min-point voltage 1 of motor 1 (Pr.01-04)
Mid-point frequency 2 of motor 1

(Pr.01-05)

01:Password Decoder

Noohw

®

15.
16.

17. Mid-point voltage 2 of motor 1 (Pr.01-06)

18. Min. output frequency of motor 1
(Pr.01-07)

19. Min. output voltage of motor 1 (Pr.01-08)

20. Output frequency upper limit (Pr.01-10)

21. Output frequency lower limit (Pr.01-11)

22. Acceleration time 1 (Pr.01-12)

23. Deceleration time 1 (Pr.01-13)

24. Over-voltage stall prevention (Pr.06-01)

25. Derating protection (Pr.06-55)
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2.

3.

VFPG Mode

SVC Mode

01: Password Decoder

26.

27.
28.

29.
30.
31.
32.

Software brake chopper action level
(Pr.07-00)

Speed tracking during start-up (Pr.07-12)
Emergency stop (EF) & force to stop
selection (Pr.07-20)

Torque command filter time (Pr.07-24)
Slip compensation filter time (Pr.07-25)
Torque compensation gain (Pr.07-26)
Slip compensation gain (Pr.07-27)

Items

9.
10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.

21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.

Parameter protection password input
(Pr.00-07)

Parameter protection password setting
(Pr.00-08)

Control mode (Pr.00-10)

Speed control mode (Pr.00-11)

Load selection (Pr.00-16)

Master frequency command source
(AUTO) / Source selection of the PID target
(Pr.00-20)

Operation command source (AUTO)
(Pr.00-21)

Stop method (Pr.00-22)

Digital keypad STOP function (Pr.00-32)
Max. operation frequency (Pr.01-00)
Output frequency of motor 1 (Pr.01-01)
Output voltage of motor 1 (Pr. 01-02)
Min. output frequency of motor 1 (Pr.01-07)
Min. output voltage of motor 1 (Pr.01-08)
Output frequency upper limit (Pr.01-10)
Output frequency lower limit (Pr.01-11)
Acceleration time 1 (Pr.01-12)
Deceleration time 1 (Pr.01-13)
Over-voltage stall prevention (Pr.06-01)
Software brake chopper action level
(Pr.07-00)

Torque command filter time (Pr.07-24)
Slip compensation filter time (Pr.07-25)
Slip compensation gain (Pr.07-27)
Encoder type selection (Pr.10-00)
Encoder pulses per revolution (Pr.10-01)
Encoder input type setting (Pr.10-02)
ASR 1 gain (Pr.11-06)

ASR 1 integral time (Pr.11-07)

ASR 2 gain (Pr.11-08)

ASR 2 integral time (Pr.11-09)

ASR gain of zero speed (Pr.11-10)
ASR1 integral time of zero speed (Pr.11-11)

ltems

1.

N

No ok w

Parameter protection password input
(Pr.00-07)

Parameter protection password setting
(Pr.00-08)

Control mode (Pr.00-10)

Speed control mode (Pr.00-11)

Load selection (Pr.00-16)

Carrier frequency (Pr.00-17)

Master frequency command source
(AUTO) / Source selection of the PID target
(Pr.00-20)
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4.

FOCPG Mode

01: Password Decoder

22.

23.

24.

25.
26.

27.
28.

29.
30.

31.
32.

Operation command source (AUTO)
(Pr.00-21)
Stop method (Pr.00-22)

. Digital keypad STOP function (Pr.00-32)
. Max. operation frequency (Pr.01-00)

. Output frequency of motor 1 (Pr.01-01)

. Output voltage of motor 1 (Pr.01-02)

. Min. output frequency of motor 1 (Pr.01-07)
. Min. output voltage of motor 1 (Pr.01-08)
. Output frequency upper limit (Pr.01-10)

. Output frequency lower limit (Pr.01-11)

. Acceleration time 1 (Pr.01-12)

. Deceleration time 1 (Pr.01-13)

. Full-load current for induction motor 1

(Pr.05-01)

. Rated power for induction motor 1

(Pr.05-02)

Rated speed for induction motor 1
(Pr.05-03)

Number of poles for induction motor 1
(Pr.05-04)

No-load current for induction motor 1
(Pr.05-05)

Over-voltage stall prevention (Pr.06-01)
Over-current stall prevention during
acceleration (Pr.06-03)

Derating protection (Pr.06-55)
Software brake chopper action level
(Pr.07-00)

Emergency stop (EF) & force to stop
selection (Pr.07-20)

Torque command filter time (Pr.07-24)
Slip compensation filter time (Pr.07-25)
Slip compensation gain (Pr.07-27)

ltems

1.

ok w

Parameter protection password input
(Pr.00-07)

Parameter protection password setting
(Pr.00-08)

Control mode (Pr.00-10)

Speed control mode (Pr.00-11)

Master frequency command source (AUTO)
/ Source seletion of the PID target
(Pr.00-20)

Operation command source (AUTO)
(Pr.00-21)

Stop method (Pr.00-22)

Max. operation frequency (Pr.01-00)
Output frequency of motor 1 (Pr.01-01)

. Output voltage of motor 1 (Pr.01-02)

. Output frequency upper limit (Pr.01-10)
. Output frequency lower limit (Pr.01-11)
. Acceleration time 1 (Pr.01-12)

. Deceleration time 1 (Pr.01-13)

. Full-load current for induction motor 1

(Pr.05-01)

. Rated power for induction motor 1

(Pr.05-02)

. Rated speed for induction motor 1

(Pr.05-03)
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5.

TQCPG Mode

01: Password Decoder

18.

19.

20.

21.

22.
23.

24.

25.
26.
27.
28.
29.
30.
31.
32.

Number of poles for induction motor 1
(Pr.05-04)

No-load current for induction motor 1
(Pr.05-05)

Over-voltage stall prevention
(Pr.06-01)

Over-current stall prevention during
acceleration (Pr.06-03)

Derating protection (Pr.06-55)
Software brake chopper action level
(Pr.07-00)

Emergency stop (EF) & force to stop
selection (Pr.07-20)

Encoder type selection (Pr.10-00)
Encoder pulses per revolution (Pr.10-01)
Encoder input type setting (Pr.10-02)
System control (Pr.11-00)

Per-unit of system inertia (Pr.11-01)
ASR1 low-speed bandwidth (Pr.11-03)
ASR2 high-speed bandwidth (Pr.11-04)
Zero-speed bandwidth (Pr.11-05)

Items

1.

o s

o

S©eN

12.

13.

14.

15.

16.

17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.

Parameter protection password input
(Pr.00-07)

Parameter protection password setting
(Pr.00-08)

Control mode (Pr.00-10)

Speed control mdoe (Pr.00-11)

Master frequency command source (AUTO)
/ Source selection of the PID target
(Pr.00-20)

Operation command source (AUTO)
(Pr.00-21)

Max. operation frequency (Pr.01-00)
Output frequency of motor 1 (Pr.01-01)
Output voltage of motor 1 (Pr.01-02)
Full-load current for induction motor 1
(Pr.05-01)

. Rated power for induction motor 1

(Pr.05-02)

Rated speed for induction motor 1
(Pr.05-03)

Number of poles for induction motor 1
(Pr.05-04)

No-load current of induction motor 1
(Pr.05-05)

Over-voltage stall prevention
(Pr.06-01)

Software brake chopper action level
(Pr.07-00)

Encoder type selection (Pr.10-00)
Encoder pulses per revolution (Pr.10-01)
Encoder input type setting (Pr.10-02)
System control (Pr.11-00)

Per-unit of system inertia (Pr.11-01)
ASR1 low-speed bandwidth (Pr.11-03)
ASR2 high-speed bandwidth (Pr.11-04)
Zero-speed bandwidth (Pr.11-05)
Max. torque command (Pr.11-27)
Torque offset source (Pr.11-28)
Torque offset setting (Pr.11-29)
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My Mode

Press F4 in parameter
setting screen to save
the parameter to My
Mode. To delete or
correct the parameter,
select this parameter
and press F4 for DEL in
the bottom right corner.

28. Torque command source (Pr.11-33)

29. Torque command (Pr.11-34)

30. Speed limit selection (Pr.11-36)

31. Forward speed limit (torque mode)
(Pr.11-37)

32. Reverse speed limit (torque mode)
(Pr.11-38)

ltems

It can save 1-32 sets of parameters (Pr).
Setup process
1. Go to Parameter Setup function.

Press ENTER to select the parameter to
use. There is an ADD on the bottom right
corner of the screen. Press F4 to add this
parameter to My Mode.

2. The parameter (Pr) displays in

My mode if it is properly saved.
To correct or to delete this parameter, press
F4 for DEL.

3. To delete a parameter, go to My Mode and

select the parameter to delete.

Press ENTER to enter the parameter
setting screen. DEL appears in the bottom
left corner of the screen. Press F4 to delete

this parameter from My Mode.
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4. After you press ENTER to delete <01 Control
Mode>, the <02 Maximum Operating
Frequency > automatically replaces <01
Control Mode>.

3. Application Selection List

This function enables you to select application and its parameters sets.

Example:
In the menu content, select 3: Application Selection List

Press ENTER to go into the Application Selection List

—

Select Application
Press ENTER to enter the application selection screen, and the selected
application industry is “Fan”.

Press ENTER to enter the Fan application screen.

Press the Up / Down keys to select the parameter to set.

Choose 0: Normal duty or 1: Heavy duty according to your needs, then press
ENTER.
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4.

Changed List

This function records the parameters you have changed.

Example:
Set Pr.13-00 Application Selection = 3: Fan

-

Enter the changed list screen. List PrNum=026 means that there are 26
parameters that have been changed.

Press ENTER to enter the changed list screen.

Use the Up / Down keys to select the parameters to check or to change.
Press ENTER to enter the parameter.

Copy Parameter

i.‘.

|
!
Press@to go to

001-004 content storage

Four groups of parameters are available to copy
The steps are shown in the example below.

Example parameter saved in the motor drive.

1. Go to Copy Parameter
2. Select the parameter group to copy and press ENTER.

1. Select 1: keypad>VFD
2. Press ENTER to go to the “keypad—>VFD” screen.

Begin copying parameters until it is done.

After copying is done, the keypad automatically returns to
this screen.

Example parameter saved in the keypad.

1. Go to Copy parameter
2. Select the parameter group to copy and press ENTER.
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Press ENTER to go to the “WVFD->keypad” screen.

Press the Up / Down keys to select a symbol.
Press the Left / Right keys to move the cursor to select a
file name.

String & Symbol Table:

" #38%& () %+ —-,0123456789::<=>?@ABCDEFG
HIJKLMNOPQRSTUVWXYZ (\N)~_ ‘abcdfghijklmno
parstuvwxyz { |} ~

After you confirm the file name, press ENTER.

Begin copying parameters until it is done.

After copying parameters is done, the keypad
automatically returns to this screen.

Press the Right key to see the date of the parameters
copied.

Press the Right key to see the time of the parameters
copied.

Fault Record

I
|

I
Press@to see an error

record’s details.

. |Able to store 30 error codes (Keypad V1.20 and later version)

Able to store 6 error codes (Keypad V1.02 and previous versions)

The most recent error record shows as the first record. Choose an error record to
see details such as date, time, frequency, current, voltage, and DC bus voltage)

Press the Up / Down keys to select an error record.
Press ENTER to see that error record’s details.

Press the Up / Down keys to scroll through an error
record’s details such as date, time, frequency, current,
voltage, and DC bus voltage.

Press the Up / Down keys to select the next error code.
After selecting an error code, press ENTER to see that
error record’s details.
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8.

|
e
d
]
i

=Y NOTE]

Press the Up / Down keys to see an error record’s details
such as date, time, frequency, current, voltage, and DC
bus voltage.

The AC motor drive actions are recorded and saved to the KPC-CC01. When
you remove the KPC-CCO01 and connect it to another AC motor drive, the
previous fault records are not deleted. The new fault records of the new AC
motor drive continue to be added to the KPC-CCO01.

Language Setup

Use the Up / Down keys to
select the language, and than
press ENTER.

1. English
2. ERPX
3. (BRI
4. Turkge

6
7.
8

The language setting option is displayed in the language of your choice.
Language setting options:
5.

Pycckuin 9. Polski
Espafiol 10. Deutsch
Portugués 11. ltaliano
Francais 12. Svenska

Time Setup

Use the Left / Right keys to

Minute or Second to change.

select Year, Month, Day, Hour,

Press the Up / Down keys to set the Year

Press the Up / Down keys to set the Month

Press the Up / Down keys to set the Day

Press the Up / Down keys to set the Hour

Press the Up / Down keys to set the Minute

Press the Up / Down keys to set the Second
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Press ENTER to confirm the Time Setup.

(==K NOTE|

Limitation: The charging process for the keypad super capacitor finishes in
about 6 minutes. When the digital keypad is removed, the time setting is
saved for 7 days. After 7 days, you must reset the time.

Keypad Locked

Press@to lock

Lock the keypad

Use this function to lock the keypad. The main screen does not display
“keypad locked” when the keypad is locked; however, it displays the
message "Press ESC 3 sec to UnLock Key” when you press any key.

When the keypad is locked, the main screen does not
indicate the lock status.

Press any key on the keypad; a message displays as
shown on the left.

__ = =
l
41|

If you do not press the ESC key, the keypad
automatically returns to this screen.

Press any key on the keypad, a message displays as
shown on the left.

__ = =
l
et

Press ESC for 3 seconds to unlock the keypad; the
keypad returns to this screen. All keys on the keypad
is functional.

[7

All keys on the keypad is functional. Turning the power off and on does not
lock the keypad.

PLC Function

!

Press the Up /Down keys to
select a PLC function, and
then press ENTER.

When activating and stopping the PLC function (choosing 2: PLC Run or 3:
PLC Stop), the PLC status displays on main screen (Delta default setting).

Choose option 2: PLC Run to enable the PLC
function.

The default on the main screen displays the PLC /
RUN status message.

t |
i
|
| |
2

Choose option 3: PLC Stop to disable the PLC
function.

The default on the main screen displays the PLC /
STOP status message.
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11.

If the PLC program is not available in the control
board, the PLFF warning displays when you choose
option 2 or 3.

In this case, choose option 1: Disable to clear PLFF
warning.

Copy PLC

Four groups of parameters are available to copy.
The steps are shown in the example below.

Example: PLC program saved in the motor drive.
1. Go to Copy PLC
2. Select the PLC program to copy and press ENTER.

1. Select 1: Keypad->VFD
2. Press ENTER to go to the “Keypad—>VFD” screen.

Begin copying the PLC program until it is done.

After copying is done, the keypad automatically
returns to this screen.

If you select “Option 1: Keypad->VFD”, check if the
PLC program is built-in to the KPC-CCO01 keypad. If
the PLC program is not available in the keypad when
you select “Option 1: Keypad>VFD”, an “ERR8
Warning: Type Mismatch” displays on the screen.

If you unplug the keypad and plug it back while
copying the PLC program, the screen displays a CPLt
warning.

|

|

I‘

1
i =

Example: PLC program saved in the keypad.

1. Go to Copy PLC.
2. Select the PLC program to copy and press ENTER.

Press ENTER to go to the “WVFD->Keypad” screen.

If the WPLSoft editor is installed uses password, enter
the password to save the file to the keypad.

Press the Up / Down keys to select a symbol.
Press the Left / Right keys to move the cursor to
select a file name.

String & Symbol Table:

T HESX& (O x+>—- /0123456789 :<=>?@AB
CDEFGHIJKLMNOPQRSTUVWXYZ (N]J~_  ‘abcd
fehijklmnopgrstuvwxyz {|}~
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After you confirm the file name, press ENTER.

Begin copying the PLC program until it is done.

After copying is done, the keypad automatically
returns to this screen.

Press the Right key to see the date of the program
copied.

Press the Right key to see the time of program copied.

Lot

Press@to go to the setting

screen.

Press the Up / Down keys to adjust the setting
value.

For example, increase Contrast to +10.

After you set the value, press ENTER to see the
screen display after contrast is adjusted to +10.

Then press ENTER and decrease the Contrast to
-10.

Press ENTER to see screen display after contrast
is adjusted to -10.

Press ENTER to go to the Back-Light Time Setting
screen.

Press the Up / Down keys to adjust the setting
value.
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13.

When the setting value is 0 Min, the backlight
remains on.

When the setting value is 10 Min, the backlight
turns off in 10 minutes.

Press ENTER go to the Text Color Setting
screen.

The default value is White Text.

Press the Up / Down keys to adjust the setting
value, and then press ENTER.

Displ Setup

v1:Contrast
2:Back-Light
3:Text Color

The setting value changes to Blue Text.

Start-up

.Default1 DELTALOGO

. Default2  DELTA Text

. User Defined: an optional accessory is required (TPEditor & USB / RS-485
Communication Interface-IFD6530) to design your own start-up screen.
If the editor accessory is not installed, the User Define option displays a
blank screen.

USB/RS-485 Communication Interface-IFD6530
Refer to Chapter 07 Optional Accessories for more details.

TPEditor
Download TPEditor software at Delta website. Select TPEditor version 1.60
or above. Refer to the installation instruction for TPEditor in Section 10-3.
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14. Main page
' 1. Default page

Default screen and editable F 60.00Hz >>> H >>>A>>>U (options rotate)
screen are available. 2. User Define: an optional accessory is required (TPEditor & USB / RS-485
Press@to select. Communication Interface-IFD6530) to design your own main screen.

If the editor accessory is not installed, the User Define option displays a
blank screen.

USB/RS-485 Communication Interface-IFD6530
Refer to Chapter 07 Optional Accessories for more details.

TPEditor
Download TPEditor software at Delta website. Select TPEditor version 1.60
or above. Refer to the installation instruction for TPEditor in Section 10-3.

15. PC Link

N . 1. TPEditor: This function enables you to connect the keypad to a computer
then download and edit user-defined screens.

Press ENTER to go to Waiting to connect to PC
screen.

In TPEditor, from the Communication menu, choose Write to HMI.

eini BN T T TR T e R
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tiraMasd[{ ANDAOFERITONE ¥ R e i A 1|
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FID taxget o

YR 0 HH:MM 55

In the Confirm message box, click YES.
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The software starts downloading screens to
edit to the KPC-CCO1.

Download completed

2. VFDSoft: this function enables you to link to the VFDSoft then upload the
parameters 1—4 you have saved in the KPC-CCO01.

J=)noTE|

If the Operation System (OS) of your computer is Windows 10, right-click
the VFDSoft icon to enter the Property. Then, click the Compatibility
tab and select the Run this program as an administrator checkbox.
(as shown in the red frames in the figure below)
b Delta VFDSoft 1.56 Properties X

Security Details
General Shortcut

Compatibility
If this program isn't working comectly on this version of Windows,

try runining the compatibility troubleshooter.
| Run compatibilty troubleshoater |

How do | choose compatibility settings manualy?
Compatibilty mode
[ Run this program in compatibility mode for:
Windows 8

Settings

[ Reduced color mode

.3«b_ﬂ QBB) calar

[ Run in 640 x 480 screen resolution

[ Disable display scaling on high DP| settings
I Run this program as an administrator I

| Gl:haﬂgeseﬁmgsfo(a]lum |

LK Cemedl | A

3. Connecting the KPC-CCO1 to a computer

Select 2: VFDSoft, and then press ENTER.
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Press the Up / Down keys to select a
parameter group to upload to VFDSoft.

Press ENTER to go to Waiting to connect to
PC screen.

Open VFDSoft and click Parameter on the toolbar
Fla Onee Ousgnonic Ozecm: sl

sUEy »rI Al

I
ff

ey .

Ll d

In Parameter Manager, from the Table menu, choose Read from KPC-CCO01.

| o8 e | w0 2+ 0000w

Choose the correct communication port and click OK.
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Uploading parameter is completed

Before using the user-defined start-up screen and user-defined main
screen, you must preset the start-up screen and the main screen as user-
defined. If you do not download the user-defined screen to the KPC-CCO01,
the start-up screen and the main screen are blank.
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16. Start Wizard (applicable for C2000 Plus firmware V3.05 and above)
16.1 New drive start-up setting process

When a new drive is powered on, it directly enters the Start Wizard. There are three modes in
the start-up setting process: Start Wizard, Exit Wizard and Test Mode.

(1) Start Wizard:

® In Start Wizard, you can set drive’s parameters such as Calendar, Maximum operation
frequency and Maximum voltage...; refer to Table 1 for setting items and orders.

® The drive exits Start Wizard when you finish the complete setting process, and will not
enter this process when rebooting the power.

(2) Exit Wizard:

® Exit the Start Wizard mode. The drive does not go to Start Wizard when rebooting the
power.

(3) Test Mode:

® This function is hidden to avoid misuse. Refer to the following flow chart to enter Test
Mode.

® \When the drive is in Test mode, it temporarily disables the Start Wizard and Exit Wizard
mode.

® The Test Mode is designed for distributors / suppliers / clients to manage and operate
the drive before shipping it out.

® If you enter Test Mode without exiting the Start Wizard process, the drive will begin with
the new drive start-up process upon next power on.

S(;tgg? Description Parameter
1 Calendar N/A
2 Output frequency of motor 1 01-01
3 Output voltage of motor 1 01-02
4 Full-load current for induction motor 1 (A) 05-01
5 Number of poles for induction motor 1 05-04
6 Rated speed for induction motor 1 (rpm) 05-03
7 Minimum output frequency of motor 1 01-07
8 Maximum operation frequency 01-00
9 Master frequency command source (AUTO) / Source 00-20

selection of the PID target
10 Operation command source (AUTO) 00-21
1 V/F curve selection 01-43
12 Acceleration time 1 01-12
13 Deceleration time 1 01-13

Table 1: Start Wizard setting items
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Flow chart for the above setting process:

Start-up Page

XThe following process takes
60 Hz default as an example

[F1]/[Fa)s[Esc]

:

>

X The drive enters
“New drive start-up setting”
after rebooting the power.

> Finish Start Wizard setting.
The drive does not enter
"New drive start-up setting”
after rebooting the power.
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16.2 Re-start Start Wizard

Use A ¥ keys
to select
"16" Start Wizard

Refer toitem 16.1 “New drive start-up setting”
for further setting procedure

NOTE: The “16: Start Wizard” on the menu is to set whether the screen shows start wizard when
powering on the drive.
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Other displays

When a fault occurs, the screen display shows the fault or warning:

1. Press the STOP / RESET key to reset the fault code. If there is no response, contact your local distributor or
return the unit to the factory. To view the fault DC bus voltage, output current and output voltage, press MENU
and then choose 6: Fault Record.

2. After resetting, if the screen returns to the main page and shows no fault after you press ESC, the fault is
cleared.

3. When the fault or warning message appears, the LED backlight blinks until you clear the fault or warning.

Optional accessory: RJ45 Extension Lead for Digital Keypad

Part No. Description
CBC-K3FT RJ45 extension lead, 3 feet (approximately 0.9 m)
CBC-K5FT RJ45 extension lead, 5 feet (approximately 1.5 m)
CBC-K7FT RJ45 extension lead, 7 feet (approximately 2.1 m)
CBC-K10FT RJ45 extension lead, 10 feet (approximately 3 m)
CBC-K16FT RJ45 extension lead, 16 feet (approximately 4.9 m)

Note: When you need communication cables, buy non-shielded, 24 AWG, four-wire twisted pair, 100 ohms
communication cables.
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10-3 TPEditor Installation Instruction

TPEditor can edit up to 256 HMI (Human-Machine Interface) pages with a total storage capacity of 256 KB.

Each page can include 50 normal objects and 10 communication objects.

1) TPEditor: Setup & Basic Functions

1. Run TPEditor version 1.60 or above by double-clicking the program icon.

TPEditor 1.60

2. On the File menu, click New. In the New project dialog box, for Set Device Type, select DELTA VFD-C
Inverter. For TP Type, select VFD-C KeyPad. For File Name, enter TPEO and then click OK.

New Project

HMI<=-PLC
Set Deice Type
| DELTA VFD-C Iuverter ~|

TE Type
[WFD-C FeyPad =

File Namz
[TPED

COK Cancel

3. The editor displays the Design window. On the Edit menu, click Add a New Page. You can also right-click
on the TP page in the upper right corner of the Design window and click Add to add one more page(s) to
edit.

=" TREN - Dyl TFEdshis
FieF) EEE) Tww(T) Coopiee) Chwsio) Looal Fage Semnpl) Mol Svmnpfd) Commumstondh fookiT) Wadow(W) Helplilh

NGWBIRs  OD ADw cheh 8 8 & . P |
N ANZANASSDOWE NOmoereceen ——-—

Qrendl

Fropey |

B0, ¥4 Devace Type: DELTA VPDAC ey Michine Type VFELC R

4. Edit the start-up screen.
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5. Add static text. Open a blank page (step 3), then on the toolbar click | A . Double-click the blank page to
display the Static Text Setting dialog box, and then enter the static text.

IeME0osiDm Wi Al 0q E5 = =
RAvsnann=nasy HoNLER §NOEOSMOOQB0E: ===

78 RoAA TAR A T E1E ¥as-n W an

RuYR Lo T (1, 2 (W1, el Dirvce Tror DELTA I8 Frivs Bt Troe TPRD

6. Add a static bitmap. Open a blank page (step 3), then on the toolbar, click . Double-click the blank

page to display the Static Bitmap Setting dialog box where you can choose the bitmap.

USNAGEF A0S N - dd 29 S5 =8 [ 3
RANEIOAS =g CIIOWAES ¥ [NOB00r00G0OR | ——=

D VB— s Bl L Pl Rl - s i Ty THACE

You can only use images in the BMP format. Click the image and then click Open to show the image in

the page.

7. Add a geometric bitmap. There are 11 kinds of geometric bitmaps to choose. Open a new blank page (step

3), then on the toolbar click the geometric bitmap icon that you need | NOEOCO OO0 Am | .

In the page, drag the geometric bitmap and enlarge it to the size that you need.

8. When you finish editing the start-up screen, on the Communication menu, click Input User Defined

Keypad Starting Screen.
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9. Download the new setting: On the Tool menu, click Communication. Set up the communication port and

speed for the IFD6530. There are three speeds available: 9600 bps, 19200 bps, and 38400 bps.

10. On the Communication menu, click Input User Defined Keypad Starting Screen.

11. The Editor displays a message asking you to confirm the new setting. Before you click OK, on the keypad,
go to MENU, select PC LINK, press ENTER and then wait for few seconds. Then click YES in the

confirmation dialog box to start downloading.

3 - e TP
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e
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DELTA VFD C2000 L
X-YV-Z 3auis station
H-axls
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2) Edit the Main Page and Download to the Keypad
1.  Inthe Editor, add a page to edit. On the Edit menu, click Add a New Page. You can also right-click on the

TP page in the upper right corner of the Design window and click Add to add one more pages to edit.

This keypad currently supports up to 256 pages.

Ty s T
] BED Y Compal) Domeen Ao Fage temegel ot lemegmdl  Coreemeh o
Ismsoes 0D dfludd ol 4
anu R ANRSOASTIOWE . A
AOHOOCOOER0 ==

o EE e

R T ST P Ry

2. In the bottom right-hand corner of the Editor, click the page number to edit, or on the View menu, click
HMI Page to start editing the main page. As shown in the picture above, the following objects are
available. From left to right they are: Static Text, ASCII Display, Static Bitmap, Scale, Bar Graph, Button,
Clock Display, Multi-state bit map, Units, Numeric Input, the 11 geometric bitmaps, and lines of different

widths. Use the same steps to add Static Text, Static Bitmap, and geometric bitmaps as for the start-up
page.

ANO=mEQAOW:E \NOHOOrOOOOY | |————|

3. Add a numeric/ASCII display. On the toolbar, click the Numeric/ASCII button. In the page, double-click

the object to specify the Refer Device, Frame Setting, Font Setting and Alignment.

WomericsSCr Dby Sovins. |
B — -
o Fameittie  [NoFrme
Font Setting ETE

[Unsiznes || Alignroent Alienleft

eme =l

| 2 R |

0K Cancel j

Click [...]. In the Refer Device dialog box, choose the VFD communication port that you need. If you
want to read the output frequency (H), set the Absolute Addr. to 2202. For other values, refer to the

ACMD Modbus Comm Address List (see Pr.09-04 in Chapter 12 Group 09 Communication Parameters).

Refer Device
Refer Device
 FLC r ; =
& Aol Addr. [0
0f1)213]4) 5] or_|
iy - 6] 7| 8]’%] AlB] Cleae
TP Poxt nMl -] C|o|E|F| .| /] o
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4.  Scale Setting. On the toolbar, click 1 {0 add a scale. You can also edit the Scale Setting in the

Property Window on the right-hand side of your computer screen.

i
SealePesition  {Top - Fent Setting

| Scale Side [Mormal Dirertion -] || o 2R

Valoe Length 1686 7] || ype e o
Mu v 100 SubSeale iz
Min Valee [0 Cancel |

a. Scale Position: specifies where to place the scale.

Scale Side: specifies whether the scale is numbered from smaller numbers to larger numbers or
from larger to smaller.

c. Font Setting: specifies the font.

d. Value Length: specifies 16 bits or 32 bits.

e. Main Scale & Sub-Scale: divides the whole scale into equal parts; enter the numbers for the main
scale and sub-scale.

f. Max Value & Min Value: specifies the numbers on the two ends of the scale. They can be negative
numbers, but the maximum and minimum values are limited by the Value Length setting. For
example, when Value Length is hexadecimal (16 bits), the maximum and the minimum value
cannot be entered as -40000.

Clicking OK creates a scale as in the picture below.

0 25 50 75 100
Illllllllllll

5.  Bar Graph setting. On the toolbar, click E to add a bar graph.

Bar Graph Setting

|~ Refer Device
Direction Sefling
Ea |From Bottorn to Top |
Value Length 16 Bits ~|
| M Vil [e2535 0K
Min Value 0 Cancel
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Refer Device: specifies the VFD communication port.

Direction Setting: specifies the direction: From Bottom to Top, From Top to Bottom, From Left
to Right or From Right to Left.

Max Value and Min Value: specifies the maximum value and minimum value. A value smaller than
or equal to the minimum value causes the bar graph to be blank (0). A value is bigger or equal to the
maximum value causes the bar graph is full (100%). A value between the minimum and maximum

values causes the bar graph to be filled proportionally.

6. Button ®:onthe toolbar, click e Currently this function only allows the keypad to switch pages; other

functions are not yet available (including text input and insert image). In the blank page, double-click e

to open the Button Setting dialog box.

Bution Setling
]

Button Type Framie Setting Single Frame -
Font Setting g =
Text Alignment Bitmap Alignment
(e |Middle || Midde ~|
—— e
Graph Inpt
2 Mt [ i [N ]
[ L - e
‘wrrent State 0 | Sitmap Fead
3l — -
1 =1 Tser Level 0 Bibesip et
| Button Text | . Ok - ‘

Button Type: specifies the button’s functions.

Page Jump and Constant Setting are the only functions currently supported.

A. Page Jump Setting

Page Jump Setting: in the Button Type list, choose Page Jump to show the Page Jump Setting.
Function Key: specifies the functions for the following keys on the KPC-CCO01 keypad: F1, F2, F3,
F4, Up, Down, Left and Right. Note that the Up and Down keys are locked by TPEditor. You cannot
program these two keys. If you want to program Up and Down keys, on the Tool menu, click

Function Key Setting, and then click Re-Define Up/Down Key.

BEIE
Took(T) Window(W) Help(H)
1 '.'_" Comrication Settings{C) '

3 Re-Define Up/Down Kew(R) |

o
Chrid Setting () g
Language Setting (L) k -

M S R - TP Page
o}
Boot Page

Button Text: specifies the text that appears on a button. For example, when you enter Next Page

for the button text, that text appears on the button.
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This function specifies the memory address’ values for the VFD or PLC. When you press the Function

Key, it writes a value to the memory address specified by the value for Constant Setting. You can use

this function to initialize a variable.

| Button Setring
Conslat Setting
BunonTye [ Constant Seemg =l | Frame Setang Single Frame =l
: Font Setmg 8 _._;
[ Tl | TSt il
r i (e =] || [Mute <]
[!: Facionkey [P = I [Midge <] || [Mige -]
| Ve Length 16 Ere =] || rea Graph gt
Vishue: Type Unsigned > =
Sy o [cee)
Crprrtnt S Fooad ]
Ii = || Uslenl = o
Brtton Text | Ak | |

Clock Display Setting: on the toolbar, click E . You can display the time, day, or date on the keypad.
Open a new page and click once in that window to add a clock display.
Choose to display Time, Day, or Date on the keypad. To adjust time, go to #8 on the keypad’s menu. You

can also specify the Frame Setting, Font Setting, and Alignment.

Clock Display Setting

Frame Setting ’m
Font Setting [ Align Left =
T s et St =
@ TF Tuor -y
o Time ¢ Day " Date
£ Pl
ok | Cancel

Multi-state bitmap. This object reads a bit’s property value from the PLC. It defines the image or text that

Multi-state bitmap: on the toolbar, click . Open a new page and click once in that window to add a

appears when this bit is 0 or 1. Set the initial status (Current State) to be 0 or 1 to define the displayed

image or text.

Redes Device
Mo "
= Graph lngut
Bt Vike
= Meez]
=l _BimapRead |
Bitmap Clear
Total Stars =
Curent St 0 =] | | Texthaput
, . Font Settng |
| oK Cancel
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A

Open a new blank page, and double-click on that window to display the Units Setting dialog box.

9.  Unit Measurement: on the toolbar, click

Choose the Metrology Type and the Unit Name. For Metrology, the choices are Length, Square Measure,
Volume/Solid Measure, Weight, Speed, Time, and Temperature. The unit name changes automatically

when you change metrology type.

Dnits Sething

Metology Type ([ E-RRRRR ~ |
Unit Marne [z =]
ok | Cancel

10. Numeric Input Setting: on the toolbar, click =
This object enables you to provide parameters or communication ports (0x22xx) and to input numbers.
Open a new file and double click on that window to display the Numeric Input Setting dialog box.

Numeric Input Sethng m

Refer Device OutLine Setting -

Write 21008 | || Prame Seting Mo Frame |
" Read | i Font Setting 5xd -

Horl, Alignment | Middle -
™~ Function ey |

= Al Vert, Alignroent [Middle ~

~Call Seting =
Vs Type e | M
Vilislemgh  |16Bi5 =

Value Setting = :
et |5 =] ||| e E
Decimal Nurnber 0 = ]

Lirait Setting '
MinVane 0 ein o=

May Valne 65535

ok e |

a. Refer Device: specifies the Write and the Read values. Enter the numbers to display and the
corresponding parameter and communication port numbers. For example, enter 012C to Read and
Write Parameter Pr.01-44.

b. OutLine Setting: specifies the Frame Setting, Font Setting, Hori. Alignment, and Vert.
Alignment for the outline.

c. Function Key: specifies the function key to program on the keypad in the Function Key box. The
corresponding key on the keypad starts to blink. Press ENTER to confirm the setting.

d. Value Type and Value Length: specify the range of the Min Value and Max Value for the Limit
Setting. Note that the corresponding supporting values for MS300 must be 16 bits. 32-bit values
are not supported.

e. Value Setting: automatically set by the keypad itself.

f. Limit Setting: specifies the range for the numeric input here.
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For example, if you set Function Key to F1, Min Value to 0 and Max Value to 4, when you press
F1 on the keypad, then you can press Up/Down on the keypad to increase or decrease the value.
Press ENTER on the keypad to confirm your setting. You can also view the parameter table 01-44

to verify if you correctly entered the value.

11. Download TP Page: Press Up / Down on the keypad to select #13 PC Link.
Then press ENTER on the keypad. The screen displays “Waiting”. In TPEditor, choose a page that you
have created, and then on the Communication menu click Write to TP to start downloading the page to
the keypad.
When you see “Completed” on the keypad screen, the download is finished. You can then press ESC on

the keypad to go back to the menu screen.
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10-4 Digital Keypad KPC-CC01 Fault Codes and Descriptions

Status indicator for information on main screen.
“OFF” displays on the keypad if the keypad cannot

Displays “Fault” or “Warning”

read the control board status, otherwise it displays
HAND/AUTO. The default value of control board is AUTO.

Fault code
Fault code desciprtion —»
Fault Codes
LCD Display * Fault Name Description Corrective Actions

Flash memory
read error
(FrEr)

Keypad flash memory
read error

Error in the keypad’s flash memory.

1. Press RESET to clear the errors.

2. Check for any problem on Flash IC.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your authorized local dealer for assistance.

Flash memory
save error
(FsEr)

Keypad flash memory
save error

Error in the keypad’s flash memory.

1. Press RESET to clear the errors.

2. Check for any problem on Flash IC.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your authorized local dealer for assistance.

Flash memory
parameter error
(FPEr)

Keypad flash memory
parameter error

Error in the default parameters.

It might be caused by a firmware update.

1. Press RESET to clear the errors.

2. Check for any problem on Flash IC.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your authorized local dealer for assistance.

Reading AC
motor drive data
error
(VFDr)

Keypad error when
reading AC motor drive
data

Keypad cannot read any data sent from the

VFD.

1. Verify that the keypad is properly connected
to the motor drive by a communication cable
such as RJ45.

2. Press RESET to clear the errors.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your authorized local dealer for assistance.

CPU error
(CPUEr)

Keypad CPU error

A serious error in the keypad’s CPU.

. Check for any problem on CPU clock.

. Check for any problem on Flash IC.

. Check for any problem on RTC IC.

. Verify that the communication quality of the
RS-485 cable is good.

5. Shut down the system, wait for ten minutes,

and then restart the system.
If none of the above solutions works, contact
your authorized local dealer for assistance.

A OWON-=
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LCD Display *

Warning Name

Description

Corrective Actions

Commuication
error 1
(CE1)

RS-485 Modbus
illegal function
code

Motor drive does not accept the communication

command sent from the keypad.

1. Verify that the keypad is properly connected to
the motor drive by a communication cable such
as RJ45.

2. Press RESET on the keypad to clear errors.

If none of the above solutions works, contact your

local authorized dealer for assistance.

Communication
command error 1
(CK1)

Keypad
communication
data, illegal
function code
(Keypad
auto-detect this
error and display
it)

Keypad does not accept the motor drive’s

communication command.

1. Remove the keypad and reconnect it.

2. Verify if the Baud rate = 19200 bps, and the
Format = RTUS8, N, 2

3. Verify if the keypad is properly connected to the
motor drive on the communication contact by a
communication cable such as RJ45.

If none of the above solution works, contact your

local authorized dealer.

Communication

RS-485 Modbus

Motor drive does not accept the keypad’s

communication address.

1. Verify that the keypad is properly connected to
the motor drive by a communication cable such

errgr22 illegal data as RJ45.
(CE2) address 2. Press RESET to clear the errors.
If none of the above solutions works, contact your
local authorized dealer for assistance.
Keypad does not accept the motor drive's
Keypad communication command.

Communication
address error
(CK2)

communication
data, illegal data
address (Keypad
auto-detect this
error and display
it)

1. Remove the keypad and reconnect it.

2. Verify if the Baud rate = 19200 bps, and the
Format = RTUS, N, 2

3. Verify if the keypad is properly connected to the
motor drive on the communication contact by a
communication cable such as RJ45.

If none of the above solution works, contact your

local authorized dealer.

Communication
error 3
(CE3)

RS-485 Modbus
illegal data value

Motor drive does not accept the communication

data sent from the keypad.

1. Verify that the keypad is properly connected to
the motor drive by a communication cable such
as RJ45.

2. Press RESET to clear the errors.

If none of the above solutions works, contact your

local authorized dealer for assistance.

Communication
data error
(CK3)

Keypad
communication
data, illegal data
value (Keypad
auto-detect this
error and display
it)

Keypad does not accept the motor drive’s

communication command.

1. Remove the keypad and reconnect it.

2. Verify if the Baud rate = 19200 bps, and the
Format = RTUS8, N, 2

3. Verify if the keypad is properly connected to the
motor drive on the communication contact by a
communication cable such as RJ45.

If none of the above solution works, contact your

local authorized dealer.
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LCD Display *

Warning Name

Description

Corrective Actions

Communication
error 4
(CE4)

RS-485 Modbus
data is written to
read-only address

Motor drive cannot process the communication

command sent from the keypad.

1. Verify that the keypad is properly connected to
the motor drive by a communication cable such
as RJ45.

2. Press RESET to clear the errors.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact your

local authorized dealer for assistance.

Communication
slave error
(CK4)

Keypad
communication
data is written to
read-only address
(Keypad
auto-detect this
error and display
it)

Keypad does not accept the motor drive’s

communication command.

1. Remove the keypad and reconnect it.

2. Verify if the Baud rate = 19200 bps, and the
Format = RTUS, N, 2

3. Verify if the keypad is properly connected to the
motor drive on the communication contact by a
communication cable such as RJ45.

If none of the above solution works, contact your

local authorized dealer.

Communication

RS-485 Modbus

Motor drive does not respond to the

communication command sent from the keypad.

1. Verify that the keypad is properly connected to
the motor drive by a communication cable such
as RJ45.

error 10 transm|83|on 2. Press RESET to clear the errors.
(CE10) time-Out 3. Shut down the system, wait for ten minutes,
and then restart the system.
If none of the above solutions works, contact your
local authorized dealer for assistance.
Keypad does not accept the motor drive’s
Keypad (1:or|;1munica:ir<])nk(:omn"ndand;j i
fati . Remove the keypad and reconnect it.
Keypad gomm””'cat'.o N 12 Verify if the Baud rate = 19200 bps, and the
o ata, transmission _
communication time-out (Kevoad Format = RTUS, N, 2
time out ime-out ( y‘,) 3. Verify if the keypad is properly connected to the
(CK10) auto-detect. this motor drive on the communication contact by a
error and display communication cable such as RJ45.
it). If none of the above solution works, contact your
local authorized dealer.
Keypad’s TPEditor uses an unsupported object.
1. Verify that the TPEditor is not using an
unsupported object or setting. Delete
Keypad unsupported objects and unsupported settings.
o Object not 2. Re-edit the object in the TPEditor, and then
communication i
time out suppqrted by dovynload it to the keyp_ad.
(CKA10) TPEditor 3. Verify that the motor drive supports the TP

functions. If the drive does not support TP
function, the main page displays Default.
If none of the above solutions works, contact your
local authorized dealer for assistance.

(= NOTE| The warning code CExx only occurs when the communication problem is between the drive
and the keypad. It has nothing to do with the drive and other devices. Note the warning code

description to find the cause of the error if CExx appears.
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These faults occur when KPC-CCO01 cannot perform the command after clicking the ENTER key in the

copy function.

To be saved in the parameter file 1 of KPC-CCO01

Fault code description —

The current position where the fault
occurs on the parameter.

Fault code

LCD Display * Fault Name Description Corrective Actions
The parameter / file is read-only and cannot be
. written to.
R(eEalgls 1n )Iy :r?erar;%t_egnal;d file 1. Verify the specification in the user manual.

If this solution does not work, contact your local
authorized dealer for assistance.

Write in error
(ERR2)

Fail to write
parameter and file

An error occurred while writing to a parameter /

file.

1. Check for any problem on the Flash IC.

2. Shut down the system, wait for ten minutes,
and then restart the system.

If this solution does not work, contact your local

authorized dealer for assistance.

Drive operating

AC motor drive is in

A setting cannot be changed while the motor
drive is in operation.
1. Verify that the drive is not in operation.

(ERR3) operating status If this solution does not work, contact your local
authorized dealer for assistance.
A setting cannot be changed because a
parameter is locked.
Parameter AC motor drive 1. Check if the pa_rameter is locked. If it is
locked ter is locked locked, unlock it and try to set the parameter
(ERR4) parameter is locke again.
If this solution does not work, contact your local
authorized dealer for assistance.
A setting cannot be changed because a
parameter is being modified.
Parameter |AC motor drive 1. Check if the parameter is being modified. If it
changing parameter is is not being modified, try to change that
(ERR5) changing parameter again.
If this solution does not work, contact your local
authorized dealer for assistance.
A setting cannot be changed because an error
has occurred in the motor drive.

(ERR6) |cleared ' Y g

setting again.
If this solution does not work, contact your local
authorized dealer for assistance.

Warning code
(ERRY7)

Warning code is not
cleared

A setting cannot be changed because of a

warning message given to the motor drive.

1. Check if there is a warning message given to
the motor drive.

If this solution does not work, contact your local

authorized dealer for assistance.
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LCD Display * Fault Name Description Corrective Actions

Data to be copied are not the correct type, so
the setting cannot be changed.
1. Check if the products’ serial numbers to be

File type : ;
mismatch File type mismatch _copled are in the same category. If they are
in the same category, try to copy the setting
(ERRS8) again.
If this solution does not work, contact your local
authorized dealer for assistance.
A setting cannot be changed because some
data are locked.
1. Check if the data are unlocked or able to be
leassword File is locked with unlocked. If the_data are unlocked, try to
ocked q change the setting again.
(ERR9) passwor 2. Shut down the system, wait for ten minutes,

and then restart the system.
If none of the above solutions works, contact
your local authorized dealer for assistance.

A setting cannot be changed because the

password is incorrect.

1. Check if the password is correct. If the
password is correct, try to change the setting
again.

2. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your local authorized dealer for assistance.

Password fail |File password
(ERR10) mismatch

A setting cannot be changed because the

version of the data is incorrect.

1. Check if the version of the data matches the
motor drive. If it matches, try to change the
setting again.

If none of the above solutions works, contact

your local authorized dealer for assistance.

Version fail File version
(ERR11) mismatch

A setting cannot be changed because the data

copying time-out expired.

1. Try copying the data again.

2. Check if copying data is authorized. If it is
authorized, try to copy the data again.

3. Shut down the system, wait for ten minutes,
and then restart the system.

If none of the above solutions works, contact

your local authorized dealer for assistance.

VFD Time out |AC motor drive copy
(ERR12) function time-out

% The content in this section only applies to the KPC-CCO01 keypad V1.01 and later versions.
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10-5 Unsupported Functions when using TPEditor with the KPC-CCO01

1. Local Page Setting and Global Setting functions are not supported.
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2. In the Communication menu, Read from TP function is not supported.
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3. In the RTC Display Setting, you cannot change the Refer Device.

~Refer Device

Foaume 5
|m ~ .| || FontSetting | 5x8
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(¢ Time i Day " Date

™ B T

0K | Cancel I

10-41



